Chapter 4: Using the Worklist

The SEER*DMS workflow is a configurable mechanism that moves records and other system data
through the appropriate automatic and manual tasks. The workflow controls the path of a record
through the editing, screening, matching, and consolidation tasks with the ultimate goal of
incorporating it into the patient set data.

A record entering the workflow is initially processed in a series of automatic tasks. If human
attention is required in order to complete a task, a manual task is initiated. Once a staff member
completes the manual task, the record continues to the next automatic task in the workflow. The
record moves from automatic to manual processes as necessary, until it completes its journey
through the workflow.

The SEER*DMS worklist provides a view of the automatic tasks that are currently running and the
manual tasks that require attention. Manual tasks are created to process patient data, view report
output, and to review import statistics. The manual tasks displayed in the worklist are the staff’'s
“to do list”. The automatic tasks are displayed in the worklist to allow you to track the flow of data
and, in rare situations, to cancel automatic processes.

A unique Task ID is assigned to the first task created when a record enters the workflow. As that
record moves from task to task, the Task ID remains the same. The same Task ID is retained until
the record exits the workflow.

In this chapter, you'll learn about

e Accessing the Worklist

e Worklist Data Columns and Filters
e Sorting the Worklist

e Worklist Task IDs

e Assigning or Releasing Tasks

e Worklist Flags

e Report and Extract Worklist Tasks
e Terminating Manual Tasks

e Restarting Workflow Activity

e Aborting Automatic Tasks

e System Failure Tasks

e Worklist Tasks

e Workflow Listings and Reports

Accessing the Worklist

There are many ways to access the worklist: select View -> Worklist, click one of the shortcuts on
the home page, or click a worklist link in the Patient Lookup. The method that you use to access
the worklist only determines the initial filter settings. Once you are in the worklist, you will be able
to adjust the filters to view an appropriate list of tasks. Your account’s system permissions
determine which tasks you will be able to view and access.

There are numerous shortcuts to the worklist on the home page. Your registry’s standard
operating procedures will determine which links you should use. In some registries, users are
instructed to focus on tasks assigned to their account. These are displayed in the Mine tab on the
left. In other registries, staff uses worklist flags or other attributes to identify high priority tasks.
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All links in the Tasks sections on the left and right sides of the home page will take you to the
worklist. The Tasks link that appears above the tabs can be used to view all tasks for that tab. For
example, click Tasks while viewing the Mine tab to view all tasks assigned to your account
regardless of task type.

When you open a worklist task, it is assigned to your account to prevent two users from
inadvertently working on the same task. Once assigned, tasks may be rerouted to other users or
designated as unassigned. The steps and account permissions required to assign or release tasks
are described in Assigning and Releasing Tasks.

Worklist Data Columns and Filters

The following data columns are shown in the worklist:

4-2

Flags — Tags to indicate that there is something “special” about the task. Flags are
assigned to tasks to mark priority tasks, problem tasks, and tasks related to certain types of
data. Registry managers can define worklist flags.

Task — Unique ID assigned to the series of processes used to move the data through the
workflow. The same ID is maintained as a record moves from one type of task to another.
TSK is the prefix for task IDs.

Type — The type column shown to the right of Task is the type of workflow task. These are
described in the Worklist Tasks section of this chapter.

User - The user account to which the task is assigned.

Age — Length of time since the task was created (shown if the Action > Toggle Age/Date is
set to show age). Age is reset when the data move forward to a new task type.

Task Date — Date and time that the task was created. Date is reset when the data move
forward to a new task type.

ID — For most tasks, this is the ID of the Patient Set or Record that is the focus of the task
(PAT is the prefix for Patient Set IDs; REC is the prefix for Record IDs). If the processing of
a record triggered the task and the record is not yet linked to a patient set, the Record ID
will be shown. Once the record is linked to a Patient Set, the Patient Set ID will be shown.
The ID shown for a Report Output task is the system report ID (RPT prefix). The Import ID

(IMP prefix) is shown for an Import Review task. Click the Information Icon "' next to the
ID to see values of key fields.

Type — The Type column to the right of ID shows the Data Type. It is blank if the task is
not related to a record. A two-character abbreviation is used: NA = NAACCR Abstract, NM
= NAACCR Modified, DC = Death Certificate, etc. The available types of records are listed
as options in the Data Type filter.

Reg — Region. This column is only displayed if your registry’s implementation of SEER*DMS
is configured to support multiple regions. Region is assigned to a record or patient set by
registry-specific polishers. It is typically based on the region of the facility that sent the
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data. Region is not applicable to worklist tasks that do not relate to patient data, for
example, there is no region assigned to Report Output or Import Review tasks.

Event Date — This is typically date of diagnosis. If a record is the focus of the task then
the Event Date field stored in the record is used. The Event Date is calculated by a polisher
and is the date of diagnosis, if available. Otherwise, it is set to the value of another date
field on the record such as screening date, date of admission, or date of last contact (please
refer to the documentation for the Date of Event Polisher on the Polishers help page).

A date from the incoming record is used if the record has not yet been linked to a patient
set. Once the record is linked to a patient set, the date of diagnosis for a CTC is used. If
the Patient Set has multiple CTCs and all CTCs are error-free, this will be the date of
diagnosis of the CTC to which the task’s original record is linked. Otherwise this column will
contain the date of diagnosis for the earliest diagnosed CTC that has edit errors. This field
is populated in this manner to enable you to identify tasks that must be completed for the
next submission.

Facility — Reporting facility.
Site — Cancer site. The site coded on the incoming record is used if the record has not yet
been linked to a patient set. Once the record is linked to a patient set, the site and year of

diagnosis are based on a CTC in the patient set. Refer to the description of Dx Year for
description of the CTC that is selected.

Information — A text field displaying additional task-specific data items (Patient Name,
match results, IDs of failing edits for edit-related tasks, etc.).

You may filter the worklist by any fields shown in the data columns. The fields listed below are
available as filters, but not shown in worklist data columns.

Task Date - Age and Date are two expressions of the same attribute, the time that the
task was created. The worklist allows you to filter on this attribute using date filters.

Status - Use this filter to find a task based on its execution status. All manual tasks have a
status of Waiting. Automated tasks will either have a status of running or failed.

Last Name — The Last Name filter provides a convenient way to search for a task by the
patient’s last name or for patients’ whose name starts with specific letters. If the focus of
the task is a record or patient set, the patient’s full name is displayed in the Information
column.

Reportability - Use the Reportability filter to search for record tasks with a specific value
for reportability. Once the record is linked to a patient set, the patient set becomes the
focus of the task, therefore, the Reportability filter cannot be used to search for Patient Set
tasks (Visual Edit Patient Set, Resolve Patient Set Errors, for example).

Import — Use this filter to search for record tasks based on the Import ID.

Open AFL — This filter was designed to facilitate searches for records that triggered an AFL,
the AFL is still open, and the record is in an incomplete worklist task. It can also be used to
find patient sets that are in the worklist and have an open AFL.

The fields listed below are available as worklist filters in some, but not all, registry configurations.

Class Of Case — The value entered in this filter is matched against the class of case in
records associated with tasks; and the class of case in the admissions of patient sets
associated with tasks.

Vendor — This filter can only be used to search for record tasks. The value entered in this
filter is matched against the Vendor Name field in the records..

Abstracted By — The abstractor’s Contact ID with a PER prefix is included in the worklist
information field. If a Contact ID is not available, the 3-character abstractor ID is included
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in the information field. To facilitate faster searching, the Abstracted By filter executes a
match against the text stored in the worklist information field.

Instructions for setting filters are provided in the Filter Tutorial that is available on the SEER*DMS
training website: seer.cancer.gov\seerdms\manual.

Sorting the Worklist

In SEER*DMS, the data displayed in a table are sorted by the data item with a highlighted column
header (highlighted in red in the example below; other colors are used in different color schemes).
In the example below, the worklist is sorted by Task ID. The up arrow next to “Task” indicates that
the table is sorted in ascending order.

Results | Filters [0

63 items, displaying 1 to 40.

Wlrase sk o twe vl onskowe o0

TSK-6073164  Match-Consolidate 03-15-2011 04:30:47PFM | REC-3005258809 (i)
|:| n TSK-6073396 Match-Consolidate 03-15-2011 04:36:17PM REC-3005258979 (i)
o |El TSK-6112823  Match-Consolidate 04-06-2011 04:537:42FPM | REC-3005274478 (i)
[ |E| TSK-6126243 Match-Consolidate 04-08-2011 05:10:44PM REC-3005276597 (i)
[ |El TSK-6126445 Match-Consolidate 04-08-2011 05:10:34FM | REC-3005276555 (i)

You may sort a list by a column if the column header is underlined. You cannot sort the worklist by
ID or Data Type; but you can sort the worklist by the priority level assigned to Flags, Task, Task
Type, Age, and all other columns. To sort the worklist by any of the data items, click on the
corresponding column heading. To reverse the sort order, click the column header again. If you
create a saved filter, the sort order will be stored as an attribute of the filter. For more information
on using filters, please refer to Chapter 3: Using SEER*DMS.

Worklist Task IDs

A Task ID is assigned when an incoming record triggers the initial task in the workflow. As the
record moves from task to task, the same Task ID is maintained. The Task ID is shown in the TSK
menu when you are working on a task. In the example below, a Visual Edit Patient Set task is
open and the task ID is TSK-5589614.

SEER* DMS User: coyle Lookup: [i] Account | Logoff

Visual Editing: Patient Set TSK-5589614 ~ Viewr Manage v Tools~ System r Help »

When you finish a task, a message is displayed at the top of the Worklist, informing you that data
were updated. The message includes the Task ID and either the Patient Set or Record ID, as
shown below.

SEER* DMS User: coyle Lookup: Li ] Account | Logoff

Worklist View » Manage » Tools» System » Help »

[ TSk-5589614 : PAT-10923031 has been updated |

The same Task ID is retained until the processing for the record is complete and the record exits
the workflow. At that point, there will be no tasks in the workflow with that Task ID. However,
tracking information is retained in the workflow history table of the database. That history can be
viewed by opening the record in the editor and selecting Workflow History from the record menu.
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Assigning or Releasing Tasks

Requires system permission: worklist_task reassignment

When a user opens an unassigned task, the task is assigned to that user’s account. Other users
cannot access the task unless the task is released or it is reassigned to their account. Tasks can
only be assignhed to a user with the appropriate system permissions.

To assign or release an open worklist task:

1.

If you wish to set a worklist flag before you release the task or assign it to another user:

a. Select Worklist Flags from the TSK task menu (the task menu is displayed as the Task
ID and is on the menu bar next to View).

b. Check the flags that are appropriate for this task.
To assign the task to another user, select Reassign from the TSK menu.

a. Set the Action to Assign to User Account, and select a user name from the list. The list
will only include users who have the system permissions required to open the task.

b. Enter text into the Comment box. This text will be included in the e-mail notification
sent to the user receiving the task.

To designate the task as unassigned, select Task > Release from the TSK menu.

If you have the system_administration permission, Terminate and Restart will be included
on the TSK menu (Restart will only be available in tasks related to records, not patient
sets). These actions should be used with care (see the Terminating Tasks and Restarting
Tasks sections of this chapter for more information).

To use the Worklist to assign or release worklist tasks:

Select View = Worklist or use a shortcut on the Home Page to go to the worklist.

Set the appropriate worklist filters. Instructions for using the filters are provided in the
Filter Tutorial on the SEER*DMS training website: seer.cancer.gov\seerdms\manual.

The check boxes in the first column allow you to select individual items in the list. If items
are checked, actions are applied to the checked items. If no items are checked, actions are
applied to all items in the filtered list. Select the tasks or tasks to modify:

a. To select specific tasks on the current page, check the boxes to the left of the Task ID.
Check boxes can only be checked on a single page, the checks will clear if you go to
another page in the worklist.

b. Or use the filters to limit the worklist to thetasks that you wish to modify.
Select Actions > Modify.

To assign the selected tasks to one or more users:

a. Set the Action to Assign to User Account(s)

b. If you would like to select users based on a system role, select that role in the drop-
down list.

c. Check one or more user names in the list. The list will only include users who have the
system permissions required to open all of the selected tasks. If multiple users are
selected, the tasks will be divided among those users

To change the task(s) to unassigned, set the Action to Release to Unassigned List.
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7. Enter text into the Comment box. This text will be included in the e-mail notification
related to this action. SEER*DMS sends an e-mail notification to a user each time a task or
set of tasks are assigned to their account

8. Click OK. A warning will be displayed if more than 100 tasks are modified.

Worklist Flags

A worklist flag is a tag associated with a task that indicates that there is something “special” about
that task. The worklist flags provide a mechanism for searching for priority or problem tasks. For
example, a worklist flag is pre-defined in SEER*DMS to indicate that a task is related to data that is
likely to generate a new reportable case. Tasks related to new cases or new patients may be
considered a higher priority. Registry management can create worklist flags; registry staff can set
flags for a task. The flags listed below are distributed with SEER*DMS.

Flag | Description Explanation
) | Probable New Patient The automatic match task did not find a patient set that was a
Set perfect match to the abstract record. It is likely that this record

will lead to the creation of a new patient set.

(c) Probable New CTC According to the automatic match task, the abstract record will
likely result in a new CTC for an existing patient set.

The automated match found a single Patient Set that matched
with a perfect score, but did not find a CTC within the patient set
that matched. A CTC is considered to be a match if the first 3
characters of primary site match, laterality is the same or one
value is missing, and the dates of diagnosis are within 4 months.

3 | Open Follow-back Need | There is an open Follow-back Need for the Patient Set or Record
that is the focus of the task.

Problem Case This flag is never automatically assigned to a task. You can
manually assign this flag to a task using the TSK menu or via the
Modify features in the worklist. This flag is recommended for
tasks related to patient sets with particularly difficult edit errors
or other issues that require further investigation. The Problem
Case flag provides a way to filter the worklist to find difficult
tasks and reroute them to experienced registrars.

[=:] | CFO Task created when a system task, AFL Manager, or record menu
is used to build Patient Sets from casefinding or pathology report
records.

[°] | DCO Task created when a system task, the Death Clearance Manager,

or the record menu is used to build Patient Sets from death
certificate records.

[= ] | SHO Task created when a system task, the AFL Manager, or the record
menu is used to build Patient Sets from short health records.
[[7] | MDO Task created when a record is built into a Patient Set using the

Build MDO Patient Set option.
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To define or modify worklist flags (requires system_administration permission):

5.

Select System > Worklist Flags.

To create a new flag, select Actions > Add. To modify the icon or name of a flag, click
Edit for that flag.

In the Flag field:
a. Specify one or two characters for the flag’s icon.
b. Click Color and select the background color for the flag’s icon.

Enter the flag’s Name. The Name is shown when a user hovers over the icon and in the
list of flags displayed when a user sets flags for a task.

Enter a Description to document the purpose of the flag. Click Save.

Report and Extract Worklist Tasks

An automatic task is started when a user runs a system report or extract. When the automatic
task finishes successfully, a manual Report Output task is created and assigned to the user who
submitted the report or extract. Instructions and options for running reports and extracts are
provided in Chapter 24: Creating Reports and Extracting Data.

Report Output tasks have characteristics that differ from tasks related to records moving through
the workflow. These are described below.

The report or extract ID is listed in the ID column of the worklist (RPT or EXT prefix).

Report Output tasks can be removed by the user to whom it is assigned. The Remove
Report Output action allows you to remove a single task or a set of tasks.

Report Output tasks expire. Report output tasks related to extracts are automatically
removed after 90 days. Report output tasks related to system reports are automatically
removed after 30 days. Email notification is sent when reports expire. To keep a
permanent copy of a report or extract, you must download it to your computer or network.

You can assign a Report Output task to any user with the reports permission. This is true
regardless of the permission level assigned to the report. For example, a report designated
for managers only can be assigned to a user who has the reports permission but does not
have the reports_management permission. That user cannot initiate the report, but a
manager can assign the output to them.

To remove Report Output tasks:

To remove a single report or extract, open the task and click Remove.

To remove a set of reports or extracts, select the Report Output tasks in the worklist using
one of these methods:

a.Use the filters to create a list containing the reports to be removed.
b.Or check the box next to each Task ID.

Click Modify.

Set the Action to Remove Report Output.

Click OK.
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Terminating Manual Tasks

System permissions: system_administration

You may use the terminate feature to end manual worklist tasks. The terminate feature should be
used with extreme care when modifying tasks that relate to the processing of patient data. The
task is ended without forwarding the record or patient set to subsequent processes in the workflow.

You may terminate a single task by opening the task and selecting Terminate from the Task’s
menu. You may also terminate one or more tasks using the Modify action in the worklist.

To terminate tasks in the worklist:

1. Use the filters to create a list containing the tasks to be terminated. For example, you may
be terminating all tasks for records loaded in a particular import.

2. Carefully verify that your filter settings are correct before proceeding. Review the worklist
to see if the appropriate tasks are listed.

Click Modify.
Set the Action to Terminate.

5. Click OK and confirm the action when prompted. The tasks will be removed from the
workflow. SEER*DMS will send an e-mail notification to you and the system administrator.
An entry will be added to the record’s Worklist History indicating that the task was
terminated.

Instructions for ending automated tasks are provided in the Viewing or Aborting Automatic Tasks
section of this chapter.

Restarting Workflow Activity

System permission: system_administration

You may restart a task to re-process a record starting at a specific point in the workflow. You
cannot move data to a previous point in the worklist if a patient set is the focus of that task,
however, you can re-execute the edits on patient sets that are in Resolve Patient Set Errors tasks.

To restart the workflow activity for a record or a set of records:

To restart an open task, select Restart from the TSK menu.

To restart a set of tasks, use the filters to create a list of the tasks to be restarted.
Select Actions > Modify.

Set Action to Restart Workflow Activity.

Review the number and type of tasks. Verify that you wish to proceed.

L

Select the point in which the task will re-enter the workflow. The tasks are listed in the
order in which they occur in the workflow. You cannot push tasks forward in the workflow,
that is, you cannot restart a Screening task at the point of Matching.

a. Auto-coding — the rec-coding polishers will be executed. Review the rec-coding
polishers for the appropriate record type(s) to determine if this is an appropriate action.
The logic for each polisher is documented on the Polishers help page.

b. Record edits — all record edits will be executed. The results will determine whether a
manual Resolve Record Errors task is created as described in Chapter 8: Resolving
Record Errors. As an example, you may wish to restart tasks at this point after
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correcting a poorly defined edit that created a large number of Resolve Record Errors
tasks. If a manual edits task is not created, the record will continue moving through
the workflow.

c. Screening — the algorithm to set the reportability flag will be re-applied. These
algorithms are documented on the Screening help page. You may wish to restart tasks
at this point if the screening algorithm was modified and you wish to apply the new
algorithm to records loaded prior to the change.

d. Matching — the automatic matching task will be refreshed. This will reset the worklist
flags and information text that are set by the automatic match task.

7. If you want to release the tasks, check Set as Unassigned. Do not check this box to
retain the current assignment.

8. Click OK and then confirm the action when prompted.

If a patient set is updated by any process, the edits are re-evaluated. If the patient set is in a
Resolve Patient Set Errors task and all edits are resolved, the task will auto-close. If changes are
made to the computerized edits, you can re-execute the edits on all patient sets using the Patient
Set Edits system tasks. Resolve Patient Set Errors tasks will auto-close if all edits are resolved.
Therefore, you will rarely need to force Resolve Patient Set Errors tasks to refresh. This would only
be used if you wanted to test a change to an edit on tasks before executing the system task to
refresh edits on all patient sets.

To re-execute the edits for Resolve Patient Set Errors tasks:

To restart a set of tasks, use the filters to create a list of the edit tasks to be refreshed.

2. Select Actions = Modify.
3. Set Action to Restart Workflow Activity.
4. Select Refresh Edits in the drop-down list. The edits will be applied to each patient set. If

no edits fail, the Resolve Patient Set Errors task will be auto-closed.

Aborting Automatic Tasks
System permission: system_administration

When SEER*DMS performs an automated process, an automatic task will appear in the worklist.
These items allow users to track the progress of automatic tasks through the workflow, and view
additional information about an item, if necessary.

SEER*DMS will run most automated processes quickly, and remove the item from the worklist as
soon as the task is completed. On rare occasions, a system administrator may need to abort an
automated process. If you have the system_administration permission and determine that an
automated task needs to be canceled, open the task and click Abort Task.

System Failure Tasks

A System Failure task will be created if SEER*DMS is unable to perform a process. The task type
will be displayed in red and ‘FAILURE’ will be printed in the information text. A user who has the
permission to perform the initial task will be able to open the System Failure task. When you open
the task you will see the type of workflow activity that failed, the time and date that the activity
was started, and the runtime exception generated.

If you cannot evaluate the information, contact your registry IT staff or submit a SEER*DMS
technical support issue. Technical support team will determine if a Retry would be appropriate.
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Worklist Tasks

The manual workflow tasks are listed below.

Manual Tasks Function

Consolidate Combine data from incoming records with data previously loaded
into the system (Chapter 12: Consolidating Data).

Consolidate FUP Resolve conflicts encountered during the automated
consolidation of follow-up information (Chapter 16: Follow-up).

Image Data Entry Enter record data stored in an image file.

Import Review Review a pre-load analysis of an import in order to identify

potential errors prior to loading the records into the workflow
(Chapter 5: Importing Data Files).

Match-Consolidate Review possible matches for an incoming record (main workflow
path). Determine whether the record should be consolidated
with an existing Patient Set, or refers to a new Patient Set
(Chapter 10: Matching Incoming Records to Database).

Pathology Screening Code site, histology, behavior, grade, and the reportability flag
on records containing pathology reports. This task is typically
used to screen HL7 records; it may also be used to screen
casefinding records in some registries.

QC Patient Set Manual Quality Control tasks that can be created by registry
QC Record staff. QC Tasks can be created in the Data Search. Use the
search to select the records or patient sets and then select
Create QC Task from the Action menu.

Report Output Access the output of a report that ran offline (Chapter 24:
Creating Reports and Extracting Data).

Resolve Patient Set Errors Resolve errors identified in the final automated review of the
patient set (Chapter 14: Resolving Patient Set Errors).

Resolve Record Errors Resolve errors which must be resolved prior to screening
(Chapter 8: Resolving Record Errors).
Review Data The Review Data is a patient set task that can be created during

ad hoc editing sessions. To create the task, you select Create
Review Task from the Patient Set menu and enter instructions.

Review Special Studies A task created when a manual review is required to determine
special study eligibility. (Chapter 28: Special Studies)
Screening Screen an incoming record for reportability (Chapter 9:

Screening for Reportability).

Supplemental Match Review possible matches for data that follows the supplemental
workflow path. This task is only created if the supplemental
match algorithm includes weighted, possible match results.

Visual Edit Patient Set Review a new patient set that was auto-created from an
incoming record (Chapter 13: Visual Editing).
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Workflow Listings and Reports

To create a printout or listing of tasks in the worklist, select Export from the Actions menu. This
creates an export file in Comma Separated Values (CSV) format. Open the file in Excel to format
and print the list. These SEER*DMS system reports can be used to monitor data and tasks in the

workflow.

Report ID | Title Description
RPT-003A Tasks for Unlinked Records | Lists workflow tasks for unlinked records which are
with Closed AFLs associated with closed AFLs.
RPT-061A Workflow Location of This report lists the current location of the record
Imported Records in the workflow. It is paged by the import data file
which contained the original record.
RPT-062A Workflow Tasks by Facility Workflow tasks by source facility and diagnosis
and Year of Diagnosis year.
RPT-075A Number of Open Worklist Number of open, manual workflow tasks by year of
Tasks by Data Type diagnosis and data type.
RPT-075B Number of Open Worklist Number of open, manual workflow tasks by user
Tasks by User account (total, number of unassigned tasks, and
number assigned to each user.
RPT-082A Number of Workflow Tasks | The number of workflow tasks completed in a
Completed (by Task) specified time period. This report includes a list of
users for each type of task.
RPT-082B Number of Workflow Tasks | The number of workflow tasks completed by each
Completed (by User) user in a specified time period. This report lists
the number of tasks per user.
RPT-096A Priority Worklist Tasks This report lists records in the workflow that likely
(Probable New Patients) represent new patients.
RPT-096B Priority Worklist Tasks This report lists probable new cases for existing
(Probable New Cases) patient sets.

Using the Worklist
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